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ABSTRACT: This template and guidelines are provided to authors to assist with the formatting of the Technical Paper to achieve the requirements of the proceedings of the International Heavy Haul Conference to be hosted in Colorado Springs, Colorado, United States of America, November 2025. Please use the formatting of this document without change and refer to it for full details on the preparation of your Technical Paper. This section, the Abstract of the Technical Paper, should be self-contained and explicit, setting out the ground to be covered and the goals of the Technical Paper. The abstract should contain objectives, method, and main conclusions of the work. It should further outline a scientific contribution related to the theme of the conference. References and non-standard or uncommon abbreviations should be avoided, but if essential they must be defined at their first mention in the abstract itself. The abstract should also not contain any brand/product/company names and should be free of any commercial advertising. The suggested length for this Abstract should be between 100 and 200 words. The suggested length for the paper is 2500 – 4000 words, with a maximum of six pages.
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INTRODUCTION
[bookmark: _Hlk190252703]The main purpose of the Introduction is to enable the paper to be understood without undue reference to other sources. It should therefore have sufficient background material for this purpose. Generally, highly specialised technical papers will not need extensive introduction as interested readers may be expected to be familiar with current literature on the subject. On the other hand, when a technical paper is likely to interest Engineers working in fields outside the immediate area of the technical paper, the introduction should contain background material that could otherwise be scattered throughout the literature.

[bookmark: _Hlk190252339]GENERAL INSTRUCTIONS
Type area
The text should fit exactly into the type area of 187  272 mm (7.36"  10.71"). For correct settings of margins in the Page Setup dialog box (File menu) see Table 1. 
All text types and headings to be used in this template have been pre-defined as tags and can be found in the Styles toolbar. These can be selected without the need for setting or changing font size, line spacing, and other attributes. 

Table 1. Margin settings for A4 size paper
____________________________________
[bookmark: _Hlk190253144]Setting							 A4 size paper			
                                  ___________________
									cm			inches	
____________________________________
Top								1.2			0.47"		
Bottom							1.3			0.51"		
Left								1.15			0.45"		
Right								1.15			0.45"		
All other						0.0			0.0"		
Column width*				9.0			3.54"		
Column spacing*			0.7			0.28"		
____________________________________
* Column dialog box in Format menu.
Typefont, typesize and spacing
Use Times New Roman 12-point size and 13-point line spacing (Normal text tag). Use roman type except for the headings (Heading tags), parameters in mathematics (not for log, sin, cos, ln, max., d (in dx), etc.), and the titles of journals and books, which should all be in italics. Never use bold, except to denote vectors in mathematics. Never underline any text. Use the small font (10 point on 11 point line spacing) for tables (Table tags), figure captions (Figure caption tag), and the references (Reference text tag).
Never use letterspacing, and never use more than one space after another. To facilitate the collation of the papers, authors are requested to omit page numbers from their drafts please.  

Getting started
Preparing the new file with the correct template
Download and copy the file IHHA2025_Paper template.doc from the online portal or event website. Start by renaming the document by clicking Save As in the File menu. Name your file as follows: First three letters of the file name should be the first three letters of the last name of the first author, the second three digits should be the assigned paper identification number of the paper (e.g. HAU001.doc). Now you can type your paper, or copy a different version of your paper into this new formatted file.
Title, author and affiliation frame
The title of the paper should be typed in lower case (no caps except for proper names) and should not be longer than 75 characters. No abbreviations should be used in the title. 
Start by entering the name of the first author (first the initials and then the last name). If any of the co-authors have the same affiliation as the first author, add their names after an & (or a comma if more names follow). Type the correct affiliation (Name of the institute, City, State/Province, Country). If there are authors linked to other institutes, place the cursor at the end of the affiliation line just typed and add a hard return. Now type the name(s) of the author(s) and after a hard return, the affiliation. Repeat this procedure until all affiliations have been typed. 
All texts shall fit in a frame that should not be changed (Width: Exactly 187 mm (7.36"); Height: Exactly 73 mm (2.87") from top margin; Lock anchor).
Abstract frame
Once there are no further authors, place the cursor one space behind the word ABSTRACT and type your abstract of not more than 200 words. The top of the first line of the abstract will be 73 mm (2.87") from the top of the type area. The complete abstract will fall in the abstract frame, the settings of which should also not be changed (Width: Exactly 187 mm (7.36"); Height: Automatic; Vertical 73 mm (2.87") from margin; Lock anchor).


Layout of text
Text and indenting
Text is set in two columns of 9 cm (3.54") width, each with a 7 mm (0.28") space between the columns. All text should be typed in Times New Roman, 12 pt on 13-pt line spacing except for the paper title (18 pt on 20 pt), author(s) (14 pt on 16 pt), and the small text in tables, captions and references (10 pt on 11 pt). All line spacing is exact. Never add any space between lines or paragraphs. When a column has blank lines at the bottom of the page, add space above and below headings (see opposite column).
First lines of paragraphs directly below headings are not indented (First paragraph tag). Subsequent lines of paragraphs are indented 5 mm (0.2") (Normal,Normal text tag).
Headings
Type primary headings in capital letters roman (Heading 1 tag) and secondary and tertiary headings in lower case italics (Headings 2 and 3 tags). Headings are set flush against the left margin. Insert two blank lines (13 pt each) above every primary heading (except when at the start of the paper or top of a page) and one blank line (13 pt) beneath the primary heading. 
Headings are not indented and neither are the first lines of text following the heading indented. 
Length of paper
The suggested length for the Full Paper should be 2500 – 4000 words maximum, with a maximum of six pages, including all appendices and illustrations in the required format. Any papers longer than this may be returned for editing by the author and may miss meeting key deadlines. 
Listing and numbering
When creating a list, use either the style tag List signs or the style tag List numbers.
Equations
Use the equation editor of the selected word processing programme. Equations are not indented (Formula tag). Number equations consecutively, and place the number with the tab key at the end of the line, between parentheses. Refer to equations by these numbers. See Equation 1 below for example:
From the above, note that sin  = (x + y)z and:

	(1)
where ca = interface adhesion;  = friction angle at interface; and k1 = shear stiffness number.
For simple equations in the text, always use superscript and subscript (select Font in the Home menu). The inline equations (equations within a sentence) in the text will automatically be converted to the AMS notation standard.
Tables
Locate tables close to the first reference to them in the text and number them consecutively. Avoid abbreviations in column headings. Indicate units in the line immediately below the heading. 
Explanations should be given at the foot of the table, not within the table itself. Use only horizontal rules (lines): One above and one below the column headings and one at the foot of the table (Table rule tag: Use the Shift-minus key to actually type the rule exactly where you want it). For simple tables, use the tab key and not the table option. 
Type all text in tables in small type: 10 point on 11 point (Table text tag). Align all headings to the left of their column, and start these headings with an initial capital. Type the caption above the table to the same width as the table (Table caption tag). See for example Table 1.
Figure captions
Always use the Figure caption style tag (10 points on 11 points). Place the caption underneath the figure (see Section 5). Type as follows: ‘Figure 1. Caption’. Leave about two lines of space between the figure caption and the text of the paper.
Notes
Notes should be avoided. Insert the information in the text. In tables, the following reference marks should be used: *, **, etc., and the actual footnotes set directly underneath the table.

Photographs and figures
Number figures consecutively in the order in which they are referred to in the text, making no distinction between diagrams and photographs. Figures should fit within the column width of 90 mm (3.54") or within the type area width of 187 mm (7.36").
When a larger image of a graph or diagram is required in the technical paper, a section break should be inserted and the page format changed to single column format. Once the diagram has been inserted, another section break should be inserted and the page format changed back to two columns.
Figures, photographs, etc., can be in black/white or full colour but will be produced in the proceedings in black/white only. Please insert the high-resolution figures in the word file. Figures, etc., should not be centered, but placed against the left margin. Leave two lines of space between the actual text and figure (see Figure 1 below). 
Never place any text next to a figure. Leave this space blank. The most convenient place for placing figures is at the top or bottom of the page. Avoid placing text between figures as readers might not notice the text. Keep in mind that everything will be reduced to 75%. Therefore, 9 point should be the minimum size of the lettering in figures, and preferably, lines should be 0.2 mm (0.1") thick. Keep figures as simple as possible. Avoid excessive notes and designations.

[image: ]

Figure 1. Caption of a typical figure

Photographs should have good contrast and preferably should be in TIFF or EPS format. Photographic reproductions cut from books or journals, photocopies of photographs, and screened photographs are unacceptable. The proceedings will be printed in black/white only. 

PREFERENCES, SYMBOLS AND UNITS
Consistency of style is very important. Note the spacing, punctuation and caps in all the examples below.
· References in the text: Figure 1, Figures 2–4, 6, 8a, b (not abbreviated)
· References between parentheses: (Fig. 1), (Figs 2–4, 6, 8a, b) (abbreviated)
· Author & Author (1989) instead of Author and Author (1989)
· (Author 1989a, b, Author & Author 1987) instead of (Author, 1989a,b; Author and Author, 1987)
· (Author et al. 1989) instead of (Author, Author & Author 1989)

Always use the official SI notations:
· kg / m / kJ / mm instead of kg. (Kg) / m. / kJ. (KJ) / mm. 
· 0.50 instead of 0,50; 9000 instead of 9,000 but if more than 10,000: 10,000 instead of 10000
· × 20 instead of 20 / X20 / x 20; 4 + 5 > 7 instead of 4+5>7 but –8 / +8 instead of – 8 / + 8
· e.g. / i.e. instead of e.g., / i.e.,

Submission of DRAFT PAPER
Check whether the paper looks the same as this template: Title at top of first page in 18 point, authors in 14 point, and all other text in 12 point on 13 point, except for the small text (10 point on 11 point) used in tables, captions, and references. Also, check if the type width is 187 mm (7.36"), the column width 90 mm (3.54"), the page length is 272 mm (10.71") and that the space above the Abstract is exactly as in the sample. On the last page, equalise the text to fill the same amount of space in each column.
The final date for the submission of completed papers via the IHHA2025 online portal is June 27, 2025. Once received, papers will be the subjected to a peer review process. Authors may receive feedback and requests for alterations to papers during the review period. The print-ready papers must be submitted by October 30, 2025.
Papers will not be accepted finally for publication and presentation until such time as the peer review and alteration process has been completed to the satisfaction of the Technical Committee.
Copyright for the proceedings is held by the International Heavy Haul Association and the authors.

conclusionS
The Conclusion for the published technical paper should be self-contained and explicit, setting out the ground covered and the principal conclusions reached. The suggested length for the Conclusions is 100 to 200 words. Conclusions should state concisely the most important propositions of the paper as well as the author’s views of the practical implications of the results.
Written papers accepted for the Conference will be distributed via the event web site and conference app. The organisers reserve the right to alter the production of these various mediums of publications as circumstances dictate. 
Only original contributions to the literature are accepted for publication. In most circumstances, this means that a paper should incorporate substantial new information not previously published. Under certain circumstances, reviews or collations or analyses of information previously published in scattered form may be acceptable.

Recommendations
It is essential that all of the requirements of the guidelines are adopted by the authors as it only is in this way that the papers may be collated easily into the standard format that is necessary for production of the papers. Failure to conform to the requirements of the guidelines could result in the particular paper being rejected. 
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This template and guidelines for written papers to be presented at the International Heavy Haul Association (IHHA) Conference have been prepared courtesy of the IHHA2023 template and are to be adhered to by authors, in order to provide a uniform style and professional appearance.

References
In the text, place the authors’ last names (without initials) and the date of publication in parentheses (see examples in Section 6). At the end of the paper, list all references in alphabetical order underneath the heading REFERENCES (Reference heading tag). The references should be typed in small text (10 pt on 11 pt) and second and further lines should be indented 5.0 mm (0.2") (Reference text tag). If several works by the same author are cited, entries should be chronological.
Typography for references 
Last name, First name or Initials (ed.) year. Book title. City: Publisher.
Last name, First name or Initials year. Title of article. Title of Journal (series number if necessary) volume number (issue number if necessary): page numbers.
Examples
Grove, A.T. 1980. Geomorphic evolution of the Sahara and the Nile. In M.A.J. Williams & H. Faure (eds), The Sahara and the Nile: 21-35. Rotterdam: Balkema.
Jappelli, R. & Marconi, N. 1997. Recommendations and prejudices in the realm of foundation engineering in Italy: A historical review. In Carlo Viggiani (ed.), Geotechnical engineering for the preservation of monuments and historical sites; Proc. intern. symp., Napoli, 3-4 October 1996. Rotterdam: Balkema.
Johnson, H.L. 1965. Artistic development in autistic children. Child Development 65(1): 13-16.
Polhill, R.M. 1982. Crotalaria in Africa and Madagascar. Rotterdam: Balkema.
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